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Simcenter STAR-CCM+ Release Notes 2602

This document provides important information about Simcenter STAR-CCM+ 2602.
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Important Notes 2602
Macro API Changes 2602
CAD Package Support
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Known Issues
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New Features and Enhancements in Simcenter STAR-CCM+
2602

Enhancements to Simcenter STAR-CCM+ 2602 are presented by category:

Contents:
Simcenter X
Platform
Geometry and Meshing
Interoperability
Physics
Design Manager
Data Analysis
Industry Solutions
User Guide

Simcenter X
• For an overview of the new Simcenter X features and enhancements, see What's New in Simcenter

X

Platform
Contents:
User Experience
Deployment
High-Performance Computing

User Experience
• Chat

◦ Get instant support with AI-powered chatbot for product documentation
▪ Easy access to modeling fundamentals, best practices and examples
▪ Enhanced productivity by triggering exact and structured information presentation
▪ Only available for Simcenter X Advanced

• Simulation compression
◦ Reduced disk space with compressed simulation file

▪ Automatically compress/uncompress simulation files
▪ Improved user experience with less manual steps
▪ Transfer files faster
▪ Multithreaded, uses up to the number of cores with which the simulation was opened
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▪ Quickly view the simulation tree of a compressed file, decompression occurs when data is
needed

▪ Use ‘Save As’ menu option to change the simulation state
• Simulation Guide improvements

◦ Enhanced discoverability with simulation tree icon
▪ Click directly on the icon to quickly open the simulation guide
▪ Focus on the relevant part of the simulation
▪ Option to open guide at the same time with the simulation file

• Stage comparison
◦ Easily verify differences between all stages through stage comparison

▪ Reduced likelihood of user error
▪ Focus only on the relevant parts of the tree
▪ Active stage is clearly highlighted and can be modified in the comparison view
▪ Refresh when comparison is out of date

Deployment
• Simcenter X Advanced – Simcenter STAR-CCM+ support

◦ One simple centralized cloud-managed licensing for all Simcenter products
▪ One license for all simulation domains
▪ Ready-to use managed solution
▪ Based on trusted Simcenter simulation technology

- Simcenter STAR-CCM+, Simcenter 3D, Simcenter Amesim and Simcenter HEEDS
◦ Maximized accessibility and global license utilization

▪ 24/7 user access with named-user licensing
- Unlimited pre/post access per user on single machines

▪ Unlock all meshing and solving capabilities with single global pool of tokens
▪ Embedded data management, AI chat, design exploration
▪ For more information, please see the Simcenter X - Executive - Product overview presentation

| Highspot
• Operating System (OS) updates

◦ Added Operating System versions
▪ Certified on Linux: Alma 10.0, Rocky 10.0, SLES 15.7

◦ Retired Operating System versions
▪ Retired on Linux: RHEL 9.0/9.2, Alma 9.0/9.2, Rocky 9.0/9.2, SLES 15.6, Open SUSE Leap 15.6
▪ Retired on Windows: Windows 10 22H2, Windows 11 22H2

◦ Scheduled Operating System support changes for Simcenter STAR-CCM+ 2606
▪ To be retired on Linux: RHEL 9.4
▪ To be certified on Linux: RHEL 9.8
▪ To be retired on Windows: Windows Server 2019 1809

• Siemens License Server 5.0 support
• Relative path support for installation directory
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High-Performance Computing
• GPU-native support for Volume of Fluid (VOF) and Mixture Multiphase (MMP)

◦ Reduced time to solution with GPU-native support for VOF and MMP problems
▪ A range of testcases show more than 200 CPU core equivalence for GPUs such as NVIDIA A100

& RTX 6000 Ada
◦ Reduced cost of simulation

▪ When comparing equivalent turnaround time on CPUs
▪ Lower energy consumption

◦ Wide range of applications covered by comprehensive capabilities including:
▪ Phase interactions such as boiling, surface tension etc.
▪ Large Scale Interfaces for MMP (MMP-LSI)
▪ Adaptive time-step and sub-stepping

• GPU porting of Table(T,p) property methods (Fluid Flow)
◦ Faster turnaround times for advanced Conjugate Heat Transfer (CHT) simulations using Table (T,p)

material property method
▪ CPU-equivalent solutions ensured by maintaining a unified code base

• GPU porting of Table (T) property methods
• GPU-native segregated species solver

◦ Significantly speed up multi-component fluid transport problems with native GPU implementation
of the segregated species solver
▪ CPU-equivalent flow solutions ensured by maintaining a unified code base

• GPU acceleration for non-spherical DEM particles Community Idea
◦ Faster turnaround times for particle flow simulation with GPU-native DEM

▪ Equivalent solutions maintained between CPU and GPU
▪ 630 CPU core equivalence for 1 GPU node

• Ffowcs Williams-Hawkings model on GPU
◦ Increased acoustic application coverage on GPU with the FW-H model

▪ Support for the entire acoustic simulation on GPUs, getting the full speed up benefit
▪ On-the-fly and Steady FW-H are fully supported to run on GPUs
▪ Post FW-H using the simh workflow is supported to run on hybrid GPU configurations

• AMD GPU support on Windows
◦ Increased hardware flexibility on Windows workstations with AMD GPUs

▪ Full utilization of hardware resources for faster simulations
▪ Similar performance as on Linux

- 1 AMD W7800 GPU ~ 115+ reference CPU cores
• Adaptive utilization of CPU cores with GPU

◦ Make efficient use of CPU cores to improve GPU performance
▪ Instead of relying on 1 CPU core per GPU, leaving other cores idle
▪ For threaded applications (Interface Intersector, Virtual Body, SPH Ghost Particle Generation)

- Example: transient automotive aerodynamics with sliding mesh
• GPU scalability improvements

◦ Faster simulation times at higher GPU counts
▪ Optimized algorithms and communication strategies for more efficient GPU scaling
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• NVIDIA Blackwell GPU support
◦ Faster solutions with NVIDIA Blackwell GPUs

▪ Harness Blackwell massive parallel processing and leverage gen-to-gen GPU improvements
▪ Achieve significantly faster simulation turnaround times

B100, B200, GB200, RTX PRO 6000
▪ Explore more intricate design iterations
▪ Accelerate product innovation and time-to-market

• NVIDIA GB10 GPU support
◦ Democratized usage of GPU

▪ AI-focused GPU for faster first-end multiphysics CFD analyses
▪ Fit large models with 128 GB memory capacity

• Message Passing Interface (MPI) updates
◦ Added Message Passing Interface (MPI) versions

▪ Certified on Linux: Intel MPI 2021.16.1, Cray MPI 8 (ARM), Cray MPI 9
▪ Certified on Windows: Intel MPI 2021.16.1

◦ Retired Message Passing Interface (MPI) versions
▪ Retired on Linux: Intel MPI 2021.12, Open MPI 4.0.3
▪ Retired on Windows: Intel MPI 2021.12

• AMD MI350 GPU support
• Automatic dynamic GPU selection

◦ Better usability with optimal assignment of GPU resources without manual intervention
• Flexible process distribution with undersubscribed nodes

◦ Example on 4 hosts (8 CPU cores and 4 GPUs per node) with 10 processes (-np 10)
• AOCL 4.2.0 upgrade for performance improvements

◦ Optimized performance on AMD CPUs
• HCOLL support in Intel MPI

◦ Enables external collective operations functionality
• NVIDIA Volta GPU support removal notice

◦ Starting 2610, support for NVIDIA Volta GPU will be removed
▪ CUDA 13 upgrade planned in 2610
▪ CUDA 13 not supporting V100 GPUs
▪ Replaced by newer generations of server GPUs (Turing, Ampere, Hopper, Ada Lovelace,

Blackwell)
• Oversubscribe GPU option removal notice

◦ Starting 2602, support for oversubscribe GPU will be removed
▪ Functionality remains, but is changed by new keyword

-gpgpu ...:oversubscribe

replaced by

-processdistribution compact
• Legacy UCX 1.8.0 toolchain removal notice

◦ Starting 2602, support for legacy UCX 1.8.0 toolchain will be removed
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▪ Relying only on modern UCX 1.18.1 toolchain

Geometry and Meshing
Contents:
CAD Interoperability
3D-CAD
Surface and Volume Meshing
Motion, Overset, and Adaptive Mesh Refinement

CAD Interoperability
• CAD Import version updates

Table: Bold = Added this release

Siemens CAD Reader Supported Versions
NX Up to NX2506
Solid Edge Up to 2025 (Windows)
CATIA V5 Up to V5-6R2024 SP4
CATIA V6/3DExperience Up to R2025x
Creo- Pro/E Up to Creo 11.0
SolidWorks Up to 2025
Rhino Up to 7
JT Up to 10.7.1
Inventor Up to 2025

CAD Clients Supported Versions
Client for NX (Linux and Windows) NX2212 to NX 2512
Client for CATIA V5 CATIA V5-R2020 (R30) to V5-R2025 (R35)
Client for Creo Creo Parametric 7.0 to Creo 12.0

• Metadata import through Simcenter STAR-CCM+ Client for CATIA
◦ Improved workflow by automating metadata transfer between CATIA and Simcenter STAR-CCM+

▪ Import metadata for any level:
- Face
- Body
- Part/Component/Assembly

▪ Filter to import only what is needed
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3D-CAD
• Automatically remove logos from bodies

◦ Save time on geometry cleanup by automatically removing embossed and debossed logo details.
▪ Identify logo-like embossed/debossed details on selected bodies
▪ Remove unnecessary small features that complicate surface preparation
▪ Support filters for logo height and size to refine detection
▪ Allows retaining specific faces through selection
▪ Provides multiple preview modes for transparent quality control

• Swap body pair columns in the contact browser
◦ Easily reorganize body pairs to improve contact visualization

▪ Allow swapping selected body pairs between Side-1 and Side-2
▪ Help keep a specific body on one side for clearer auxiliary views
▪ Reduce occlusion of contact faces when visualizing complex assemblies
▪ Update the contact table and auxiliary views automatically

• Import generalized and multilump bodies using split disjointed bodies
◦ Faster CAD preparation through clean import of complex, disjointed bodies as usable manifold

geometry
▪ Support import of generalized and multilump bodies into 3D-CAD
▪ Convert disjointed geometry into separate, manifold solid or sheet bodies
▪ Preserve individual components instead of merging into a single body
▪ Improve usability of imported CAD for downstream surface preparation and meshing

• Assembly constraints for parametric positioning of bodies
◦ Enable fast, predictable assembly updates by automatically maintaining body relationships during

design changes
▪ Define geometric constraints to control how bodies are aligned and positioned relative to each

other
▪ Keep assemblies consistent as dimensions or features change
▪ Combine imported and newly created components within a single 3D-CAD model
▪ Avoid external CAD tools when preparing configurable assemblies
▪ Support efficient design exploration using parametric body positioning

• Set operations on filters and color predicate
◦ Speed up geometry preparation by using Boolean operations and color criteria to create more

powerful filters
▪ Support for complement, union, intersection, and difference operations on filters
▪ Select inverse filter results without manual rework or error-prone logic
▪ Combine multiple filters to build advanced geometry selection rules
▪ Introduce color-based selection using a dedicated Color predicate
▪ Improve workflow efficiency when isolating and manipulating complex geometry

• Support input of facet tessellation density for Boolean features
• Body shop tool support for facet bodies
• Extend repair and cleanup tools to faceted geometry (repair bodies, remove sliver faces, and

remove gashes)
• Enable Light Weight Tessellation Density Option while importing the CAD Geometry in Parts
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• Support for body instance and mixed BRep/faceted inputs within the proximity predicate

Surface and Volume Meshing
• Directed Mesh quality enhancements – Enhanced Cell Quality

◦ Improved mesh quality in thin parts through the new Enhanced Cell Quality option
▪ Minimizes misalignment of mesh vertices on guide edges
▪ Avoids the creation of negative volume cells depending on the geometry

• Automatic selection of source and target surfaces in Directed Mesh
◦ Accelerate setup time of directed mesh operations via automatic selection of source and target

surfaces
▪ Improved ease of use by eliminating the need to select intermediate source and target

surfaces manually
▪ Applicable for all geometry models especially with numerous parts
▪ Users do not need to identify a surface source/target before invoking Autopopulate Source/

Target Surfaces
• Enhanced Quality Prisms

◦ More robust prism layer mesh generation through Enhanced Quality Prisms
▪ Less prism retraction and smoother prism/core transition
▪ Does not change near wall layer thickness
▪ Built-in aspect ratio control
▪ No hanging node topology in layers transitions

- Standard cells creation for tetrahedral meshers with layer transitions
▪ Supports all volume meshers and 2D mesher

Motion, Overset, and Adaptive Mesh Refinement
• Faster sliding mesh interfaces using multi-threading

◦ Accelerated sliding mesh simulations using CPU multi-threading
▪ Faster sliding mesh simulations with caching
▪ Faster GPU-accelerated sliding mesh simulations
▪ Available in conjunction with the Metrics-based intersector

• Virtual Body support for second-order time discretization
◦ Virtual Body support for marine and aerospace applications

▪ Enables the use of second-order temporal accuracy for simulations involving Virtual Body
▪ Improved solution fidelity for unsteady flows

• Relative MRF support for Implicit Unsteady Time
◦ Accelerated transient analysis leveraging Relative MRF support for Implicit Unsteady Time

▪ Faster results for initial design screening and parameter sweeps
▪ Rapid prototyping of rotating components (e.g., wheels, propellers, turbines)
▪ Efficient global interaction analysis without resolving component-scale transients

• Performance Optimization for Virtual Body with DFBI
◦ Enhanced run-time performance when using Virtual Body in conjunction with Dynamic Fluid-Body

Interaction (DFBI)
• Virtual Body projection support for multi-threading
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◦ Accelerated Virtual Body simulation through multi-threaded vertex projection

Interoperability
• Teamcenter Integration Supported Versions

Table: Bold = Added this release

Simcenter
STAR-CCM+

Teamcenter

2406 2412 2506 2512 2606
2410 Certified
2502 Certified
2506 Certified Certified Scheduled
2510 Certified Certified Scheduled
2602 Certified Certified Scheduled

◦ Multi-Version Support
▪ Asynchronous upgrades of either Teamcenter or Simcenter STAR-CCM+ are compatible within

a range of releases. See Simcenter Compatibility Matrix.
• Import Model Exchange FMU

◦ Better control of iteration and convergence control of coupled network models
▪ Import model exchange FMU to solve equations internally
▪ More accurate even at larger time-steps
▪ Robust for stiff systems
▪ Higher performance with less exchange overhead

• Export Derived Parts to CGNS
◦ Focused export reduces size and simplifies downstream workflows

▪ Reduced file size
▪ Receiving application has exactly the data it needs
▪ Supports surface-like derived parts

- single and multiple plane, cylinder, and sphere sections
- arbitrary sections
- average surface and iso-surface
- subdivision part
- thresholds resulting in a surface

• Co-simulation mutual termination handling
◦ ▪ Save HPC resources by sending and receiving simulation termination notice from coupled

application
▪ Stop Simcenter STAR-CCM+ simulation when a coupled application signals termination
▪ Additionally supported for STAR-to-STAR and GT-Suite

• CGNS vertex export under file-export
◦ ▪ Enable vertex-based export stencil when exporting in CGNS format through file-export

▪ Consistent option and behavior with Link export
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• CAE Interoperability Supported Versions
Table: Bold = Added this release

Integration Versions
CGNS Format 4.5.0
Co-simulation API V8
Functional Mockup Interface (FMI) 2.0, 3.0
Gamma Technologies GT-SUITE 2022, 2023, 2024
Simulia Abaqus 2022, 2023, 2024
Simcenter Nastran 2406, 2412, 2506

See Simcenter Compatibility Matrix.

Physics
Contents:
Fluid Flow
Turbulence
Adjoint
Heat Transfer
Eulerian Multiphase
Lagrangian Multiphase
Discrete Element Method (DEM)
Reacting Flows
Electrochemistry
Electromagnetics
Structure Mechanics

Fluid Flow
• Automatic assignment of physics values from metadata

◦ Significant simplification of model preparation by leveraging part and part surface metadata
information
▪ A new Metadata method is available for almost all Physics Values for any physics model at the

Region level
▪ Key enabler to automate assignment of 100s or 1000s of physics settings and boundary

conditions
▪ Improved traceability of model settings across multiple CAE teams (i.e., CAD team, CFD and

more)
• Flow boundary diffusion moved from model to boundary ID-0007364

◦ Ensure cross-solver consistencies by moving boundary diffusion control from individual models to
boundary physics conditions
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▪ Addresses limitations where diffusion settings could vary between flow, energy, and species
models causing conflicts and inconsistent treatments

▪ Guarantees consistent diffusion treatment at each boundary for all active physics
simultaneously

Turbulence
• Rough Displace Origin model compatible with Realizable K-Epsilon Two-Layer ID-0020938

◦ Extend roughness modeling capabilities by removing the incompatibility of the Rough Displaced
Origin model with Realizable K-Epsilon Two-Layer turbulence model
▪ Provide a less mesh-sensitive roughness modeling approach with Realizable K-Epsilon Two-

Layer
• Improved defaults for turbulence velocity scale

◦ Ensure proper turbulence initial conditions by automatically determining turbulent velocity scale
(TVS) based on velocity initial conditions
▪ Replace the suboptimal default of 1 m/s, often not changed
▪ Enhance robustness and convergence rate by ensuring turbulence initial fields remain

synchronized with velocity conditions
• V2F K-Epsilon turbulence model removal notice

◦ In this release (2602, the V2F K-Epsilon turbulence model has been removed
▪ The recommended practice is to use one of the Elliptic Blending K-Epsilon turbulence models

Adjoint
• Update Topology operation

◦ Accelerate adjoint topology optimization studies with a new update topology operation
▪ Streamline flow, adjoint, and design update steps, avoiding unnecessary concurrent

calculations of flow and design update solvers (PDE Wall Distance, AMR, Level-Set, Repartition)
◦ Improved flow solver convergence and overall stability with optimized solvers sequencing
◦ Note: update topology operation automatically added to existing workflows

• Adjoint support for isentropic efficiency report
◦ Simplify adjoint optimization workflows for compression and expansion flows by enabling direct

use of isentropic efficiency report as cost function
▪ Eliminate need to define expression-based reports to include isentropic efficiency in adjoint

cost function

Heat Transfer
• View Factor solver improvement in thin air-gaps

◦ Improved ray-tracing robustness for cases featuring very thin gaps between parts through
algorithmic improvements
▪ Improvements noticeable for cases using both shells and 3D solid parts
▪ Impacts solutions using Surface-to-Surface as well as Surface Photon Monte Carlo radiation

models
• Single stream heat exchangers compatible with parts-based workflow
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◦ Streamlined workflow during setup preparation of large Vehicle Thermal Management simulations
by introducing compatibility between single stream heat exchanger method and parts-based
workflow
▪ Significantly reduced number of regions in setups with multiple single stream heat exchangers
▪ Easier templating and automation provided by physics values assignment in sub-groupings

• CLO unit for clothing contact resistance specification
◦ Improved user experience during clothing properties specification in thermal comfort analyses by

including the CLO unit for clothing contact resistance
• Evaporation mass rate report in Fiala Thermoregulation Model

◦ More insights into sweating effects during cabin comfort studies by adding a native report to
quantify the evaporation mass rate

Eulerian Multiphase
• Energy Compatibility with Phasic Porous Media and EMP

◦ Confidently model applications such as fuel cells and electrolyzers via Energy compatibility with
Phasic Porous Media and EMP
▪ Phasic porous media allows for complex sub-grid phenomena to be modeled where

interactions with unresolved solids are important
▪ Energy compatibility allows thermal effects to be included

• EMP/MMP: Deprecation of Spherical Particle Interaction Area Density (IAD)
◦ Superseded by Symmetrical IAD which recovers Spherical IAD for continuous-dispersed flows
◦ In this release a warning message is issued when selected; in a subsequent release will be removed

• Pre-Integrated S-Gamma: Renamed break-up and coalescence models
◦ Models previously named “Standard” have now been renamed based on original literature

▪ Viscous Breakup Timescale → Janssen
▪ Inertial Breakup Timescale → Chesters
▪ Viscous & Inertial Breakup Fragments → Binary
▪ Viscous & Inertial Critical Diameter → de Bruijn
▪ Viscous & Inertial Collision Rate → Chesters
▪ Viscous & Inertial Coalescence Probability → Chesters

Lagrangian Multiphase
• Accurate particle tracking: New triggers for Track File input

◦ Improved accuracy of the particle trajectories analysis by having access to the particle location at
the moments of complete evaporation, reaction, or impingement into Volume of Fluid (VOF) model

• Multicomponent material models compatible with parcel transfer injectors
◦ Transitioning to a more optimal model when local conditions change extended to multicomponent

particles

Discrete Element Method (DEM)
• Fiber Length distribution with constant segment length Community Idea

◦ Improved accuracy of fiber simulations with the new Constant Fiber Segment Length option
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▪ Effective stiffness of fibers consistent with theory
◦ Improved speed in simulations with a large variation in fiber length

▪ The constant segment size allows larger DEM time-steps
◦ Applications: Manufacturing of insulation or composites, pulping, grass/crop processing in

agriculture
• Evaporation models for non-spherical DEM particles

◦ Higher accuracy of solid drying simulations by enabling the evaporation models for non-spherical
particles
▪ Composite particles, cylindrical particles, capsules, and fibers are compatible with:

- Multiphase Mixture Evaporation model
- REA Spray Drying Evaporation model

Reacting Flows
• Flamelet Generated Manifold (FGM) table plotting improvements

◦ Easier insight into FGM table properties with improved plotting information
▪ Explicit table points are now selectable, with tabulated value also shown
▪ Previously, only direct selection of table point was available

• Improved flamelet molecular weight calculation
◦ Better convergence and faster time to solution with improved integration and interpolation of

flamelet table molecular weight
▪ Leads to a smoother and more consistent density field aiding convergence behavior

• Complex Chemistry Turbulent Flame Speed Closure (CC-TFC) improved unburnt temperature
calculation
◦ The methodology of predicting unburnt temperature was improved such that it is more accurate

whilst maintaining computational efficiency, particularly in cases with multiple regions
◦ Typical applications which will benefit are In-Cylinder models using Turbulent Jet Ignition (TJI)

• Multiphase Complex Chemistry heterogeneous reaction support
◦ Previously, reactions could only be considered as a homogenous mixture
◦ Now reactions can also be set as interphase reactions between two interacting phases by specifying

Interaction Area Density and concentration of reactant species relative to their phase
◦ Allows for better representation of phase interaction and therefore greater accuracy in prediction of

reaction rates in cell level thermal runaway applications

Electrochemistry
• Electrochemical and Ohmic heating compatibility with phasic porous media

◦ Accurately capture the behavior of fuel cells with compatibility between electrochemical heating
models, Eulerian Multiphase (EMP), and phasic porous media
▪ Capture complex physics of fuel cells and electrolyzers by combining detailed models
▪ See also Energy Compatibility with Phasic Porous Media and EMP

• 3D Cell Design – Voltage Hysteresis model
◦ Capture voltage hysteresis behavior with new Plett Equilibrium Potential Hysteresis model
◦ Models the impact of differing voltages during charging and discharging for e.g. Silicon-Graphite

batteries
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• 3D Cell Design – Cell Design Reports before mesh generation
◦ Quickly understand target capacity values with new meshless Cell Design reporting
◦ Previously, a mesh had to be generated prior to assessing state of charge (SOC), open-circuit

voltage (OCV), or capacity. Now these reports can be directly evaluated without a mesh
• 3D Cell Design – improved stability of Electrode Particle Diffusion model

◦ Combination of Table(T,c) method and appropriate limiting of subgrid particle diffusion
concentrations allows latest 3D Cell Design templates to be run with greater stability and higher
time-step sizes

• Further details of all these 3D Cell Design enhancements can be found in the E-Powertrain section.

Electromagnetics
• Multi-port Solid Conductor Model

◦ Broaden simulation possibilities by introducing model for voltage-driven multi-port solid conductor
systems
▪ Available in both Time and Frequency domains
▪ Easy workflow for Port-based voltage specification
▪ Allow dynamic current paths between arbitrary ports

• Regularization-free linear solver scheme for FE-Magnetic Vector Potential model
◦ Improve robustness and accuracy of results with new solver

▪ Remove possible unexpected spurious non-physical effects introduced by Regularization
parameter

▪ Ensure current conservation in Busbar, e-Machine, transformer, and plasma cases
• Time domain extension of hysteresis term of Modified Steinmetz model

◦ Increased accuracy for iron losses calculation with time-domain extensions of hysteresis term of
Modified Steinmetz model
▪ Available for Finite Element Magnetic Vector Potential and Transverse Magnetic Vector

Potential models
▪ Removes need to set Excitation Frequency
▪ Better handling the influence of arbitrary magnetic field variation

• Improved interface between High Order configuration and Air Gap Remeshing
◦ Enhance robustness and performance via optimized interfaces

• Improved integration rules for Ohmic Heating model used by Finite Element Magnetic Vector
Potential solver
◦ Improve accuracy of the Ohmic losses calculation especially for high order FE discretization

• Add Iterative Solver Option for FeExcitation Coil model
◦ Improve performance with faster initialization time for FeExcitation coil model especially in parallel

runs
• Part-based support for Excitation Coil Conductor Resistance Report

◦ Allow both region and parts-based resistance report

Structure Mechanics
• Contact Detection Performance Optimization

◦ Reduced runtime via optimization of the contact detection
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▪ Optimize performance by limiting contact detection to surfaces within proximity to contact
area

▪ Up to 15% speedup without compromising accuracy
▪ Precise control through user-defined search distance

- User’s responsibility to select appropriate value
* Too small, risks missed contacts
* Too large, reduces speedup

• Iterative-Direct Solver 2.0
◦ Accelerated performance through extensions to the Iterative-Direct solver

▪ Up to 2x speedup over Iterative-Direct 1.0
▪ Up to 3.2x speedup compared to MUMPS
▪ Ability to converge models which could not be solved with Iterative-Direct 1.0
▪ Supports single and double precision pre-conditioner, re-use of the matrix factorization,

matrix symmetrization
• Solution History support for segments

◦ Increased insight on structural loads and constraints through extended transient post-processing
capabilities on segments
▪ Segments can now be selected as input for Solution Histories (.simh)
▪ Enabling detailed analysis of effects of loads and constraints per segment

• Enhanced Linear Wedge Elements
◦ Greater choice of meshing methods for efficient modeling of thin structures

▪ Wedge element now joining the family of bending enhanced elements
▪ Supports meshes coming from Directed Mesher and Thin Mesher
▪ Accuracy and performance comparable to Enhanced Linear Hex elements

• Temperature dependent Yield Stress
◦ Enables applications that involve materials with temperature dependent plasticity

• Combine predefined transforms
◦ Easier visualization of displacements combined with other transforms like symmetries

• Rigid Contact for Structural Shells
◦ Enables efficient modeling of contact between rigid objects and thin structures

Design Manager
• Import existing simulations in Design Manager

◦ Save time and leverage prior simulation data by importing existing files
▪ Exploit existing results for surrogate models and Geometric Deep Learning

- Supports only simulation file
▪ Leverage Design Manager automated workflow to generate common post-processing
▪ Compare multiple single simulation files in a unique environment

• Geometric Deep Learning in Design Manager
◦ Accelerate design process with integrated Geometric Deep Learning

▪ Assess design variants in minutes
- Fast models leveraging best in class Neural Networks
- Support parametric and non-parametric geometries
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- Predict scalar, surface, or volume fields
▪ Fully embedded workflow in your familiar environment
▪ Support for Steady State external aerodynamics use cases

◦ Improve return on investment by leveraging capitalized data
▪ Feed the AI-based Reduced Order Model with any existing simulation

• Geometric Deep Learning in Design Manager
◦ Verify and ensure accuracy of the AI-based Reduced Order Model

▪ Compare simulated and predicted results with the new Test Study type
▪ Assess the relevance of the prediction with the Geometry Similarity Score
▪ Compare predicted and simulated design trends with the Trend metrics feature

◦ Leverage Geometric Deep Learning in Design Manager to
▪ Predict designs
▪ Run fast optimization studies
▪ Run any other Study type including Manual, Sweeps, or Smart Sweeps studies

Data Analysis
• Better user experience through plot-centric Quick Actions

◦ Improved customization workflow for Plots with new Quick Actions
▪ Quickly change properties without the need to navigate the simulation tree
▪ Clear icons enhance property discoverability

• More possibilities for coloring with color by Tag mode Community Idea
◦ Easier visual identification of parts through coloring by Tag

▪ Identify object with similar properties through user-defined color
▪ Flexible Color Assignment options to support multiple use cases
▪ Top-Down and Bottom-Up option can be used for assemblies or derived parts

• Paste stored View on other Scenes
◦ Consistent View management with simple apply and paste workflow

▪ Store and apply Views from one Scene to another
▪ Align all Scenes to a dedicated View for consistency

• Simcenter Web Viewer - Layout Support
◦ Enhanced collaboration through a single results file

▪ Export and share qualitative and quantitative data with stakeholders in Simcenter Web Viewer
▪ Dynamic interaction with both Plots and Scenes enhances any decision-making process

• Simcenter Web Viewer - Adjust range via Color Bar
◦ Better visualization of gradients with ability to adjust color range

▪ Control upper and lower bounds via Color Bar widget
• Extract more information by using per part data in Tabular Summary Object

◦ Total Report value can now be appended with per-part values
• Model uncertainty with random operator in Field Functions

◦ ▪ Generate single random numbers or random fields
▪ New numbers get generated whenever field function is evaluated
▪ Seed option allows for reproducibility of random number generation
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• Accelerated initial Scene opening
◦ Parallelized algorithm improves initial loading process by 10 percent

• More granular View control in Simcenter Web Viewer
◦ Specify a numerical angle to rotate around an axis

• Easier sizing and positioning for View Triad
◦ Place View Triad in the 4 corners of the Scene
◦ Control size with simple slider

• Simcenter STAR-CCM+ Viewer removal notice
◦ Starting 2606, Simcenter STAR-CCM+ Viewer will be removed

▪ As replacement a downloadable version of the Simcenter STAR-CCM+ Web Viewer will be
made available

▪ All features of the Web Viewer with the additional ability to process large files will be available
▪ Going forward the product name will be Simcenter Viewer

• Block-Mapped Coordinate System removal notice
◦ Starting 2606, Block-Mapped Coordinate Systems will be removed

▪ Legacy turbomachinery workflows using Block-Mapped Coordinate Systems are no longer
supported

▪ Use blade parametrization as standard workflow

Industry Solutions
Contents:
E-Powertrain
In-Cylinder
Smoothed-Particle Hydrodynamics
Turbomachinery

E-Powertrain
• Pack thermal runaway - multiple pseudo-reaction support

◦ Increased thermal runaway cell self-heating prediction with Arrhenius Multiple Pseudo-Reaction
model
▪ Arrhenius-based kinetic equations follow same formulation as in Ren et al.[1] and is popular

within the automotive industry
▪ Offers greater predictability in modeling exothermal reactions compared to table approach
▪ Supports multiple reactions such as SEI decomposition, anode-electrolyte or cathode-binder

reactions
◦ Simple and fast setup with dedicated formulation interface

▪ Easy input for kinetic equation parameters
▪ Automatic coupling between all reactions

• 3D Cell Design – Voltage Hysteresis model

1 Ren, D., Liu, X., Feng, X., Ouyang, M., Li, J., and He, X. "Model-based thermal runaway prediction of lithium-
ion batteries from kinetics analysis of cell components" Applied Energy 228 (2018) 633–644.
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◦ Increased fidelity by predicting voltage hysteresis behavior with new Plett Equilibrium Potential
Hysteresis model
▪ Models the impact of differing voltages during charging and discharging for e.g. Silicon-

Graphite batteries
▪ Activated under Equilibrium Potential options with upper and lower hysteresis envelopes user-

defined
• 3D Cell Design – Cell Design Reports before mesh generation

◦ Quickly understand target capacity values with new meshless Cell Design reporting
▪ Previously, a mesh had to be generated prior to assessing state of charge (SOC), open-circuit

voltage (OCV), or capacity
▪ Now these reports can be directly evaluated without a mesh

• Algorithmic improvement of the Geometry Vector Profile method for E-Machines
◦ Faster turnaround times for rotating E-Machine simulations via efficiency improvements of the

Geometry Vector Profile Method (GVPM)
▪ Computational cost of assigning Magnetization direction via GVPM reduced to <1% of the total

simulation time
▪ Relevant applications include E-motors, magnetic gears and rotary actuators

• 3D Cell Design – improved stability of Electrode Particle Diffusion model
◦ Combination of Table(T,c) method and appropriate limiting of subgrid particle diffusion

concentrations allows latest 3D Cell Design templates to be run with greater stability and higher
time-step sizes

In-Cylinder
• Access to coordinate systems in Construction Geometry

◦ More streamlined workflow to generate primitive shapes for mesh refinements due to coordinate
system exposure in Construction Geometry
▪ Enables direct access to coordinate systems generated by In-Cylinder at any point during the

pipeline
▪ Significantly reduces turnaround in cases, in which a block, cylinder, cone or sphere need to

be used under Mesh Controls
▪ Simplifies cases such as cylinders around pre-chamber orifices, cones around injector holes,

and spheres around spark plug electrodes
• Enhanced post-processing of Indicated Mean Effective Pressure

◦ Enhanced usability in post-processing of Indicated Mean Effective Pressure (IMEP) with a clearer and
streamlined workflow
▪ Allows for user-specified delay, until the start of the calculation, in dedicated Settings panel
▪ Defaults to an IMEP calculation at the end of simulation and every preceding engine cycle

length
◦ Reduced likelihood of unexpected results with visual information reflecting setup steps

▪ Displays a warning, upon initializing the solution, if simulation duration is shorter than an
engine cycle

▪ Automatically deactivates IMEP post-processing objects, previously created for simulation
duration shorter than an engine cycle
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Smoothed-Particle Hydrodynamics
• Vehicle wading

◦ Faster turnaround time for vehicle wading applications through the SPH solver
▪ Increased accuracy locally using particle refinement around the vehicle
▪ Resolve the dynamic motion of the car modeling the suspension and the contact between the

tire and road
▪ Analyze mechanical stresses on the backplate of the car and wetting predictions

• Energy equation
◦ Increased application coverage in cooling applications for the SPH solver through the addition of the

SPH energy equation
▪ Addition of the total energy conservation equation
▪ New fluid properties with the specification of the thermal conductivity and specific heat
▪ Boundary conditions thermal specification for both inlet and outlet: Adiabatic, Temperature,

Heat Flux, Heat Source, and Convection
• Thermal Wall Treatment

◦ Higher fidelity in heat transfer coefficient resolution with Thermal Wall Treatment
▪ Wall treatment activates both viscous and thermal wall treatment when selected with the

energy equation
▪ Specification for each boundary of the Standard Wall Function condition with

- The log law offset E
- The von Karman constant Kappa

• Plane Section Derived Part
◦ Increased qualitative and quantitative data analysis on planar sections with Plane Section Derived

Part
▪ Qualitative analysis by looking at any scalar or vector field on the created plane
▪ Quantitative analysis with Report, Monitor, and Plot

• Hollow cylinder for particle refinement
◦ Increased accuracy around the e-machine windings with hollow cylinder particle refinement shape

criteria
▪ Specification of inner and outer radius for the cylinder refinement shape

• Initialization optimization for ghost particle method
◦ Faster initialization with ghost particle method using CPU cores for the initialization, even when the

simulation is run on GPU
▪ Use CPU threads for the ghost generation within the initialization when the simulation is run

on GPU
▪ Up to 8 times faster during the initialization, depending on the number of CPU cores

• One-way fluid-structure co-simulation with Abaqus
◦ Analyze mechanical stresses and solid deformation in Abaqus through one-way fluid-structure co-

simulation
• Removal notice – Basic and Advanced for Velocity Stabilization Option

◦ Starting Simcenter STAR-CCM+ 2610, the options Basic and Advanced for the Velocity Stabilization
under Incompressible Flow (ISPH) in the Continuum will be removed
▪ Best practices recommend selecting the default option Universal
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▪ Please contact your Simcenter STAR-CCM+ customer support representative for further
information

Turbomachinery
• Improved conservation at implicit mixing planes

◦ Improve energy conservation and eliminate discrepancies of total quantities across implicit mixing
plane through imprinting of bins and conservative boundary values update
▪ Imprint Bins option ensures accurate flux conservation by imprinting the bin structure into

interface discretization
▪ Enhanced boundary values update eliminates total pressure and temperature discrepancies

across interfaces
◦ Greater solver stability with smoother residuals convergence

• Turbomachinery mesh – Optimize Surface Node Distribution
◦ Increased fidelity in blade geometry through optimized surface node distribution

▪ Automatically captures thin leading and trailing edges by increasing the node clustering
around those thin edges

▪ Automatically prevents large mesh intervals for highly curved blade
• Corrected Mass Flow boundary condition for harmonic balance

◦ Improved harmonic balance solver robustness with support for corrected mass flow outlet boundary
condition
▪ Address convergence struggles in complex compressor flows
▪ Ensure seamless boundary condition alignment between harmonic balance and coupled flow

solvers
• Turbomachinery Import Workflow – Automatic Design Parameters

◦ Easily modify and optimize blade geometry through automatic creation of Design Parameters
▪ Access and modify directly in 3D CAD or Design Manager
▪ Design Parameters created for:

- Fillet radius at leading and trailing edges
- Tip gap size

• Turbomachinery Import Workflow – Bladeless configuration
◦ Improved application coverage for large stator inlets or outlets with support for bladeless row

configurations
▪ Specification of a bladeless portion of the machine through Z position definition
▪ Additional parameter called bladeless_zposition

• Turbomachinery Import Workflow – Restart workflow
◦ Increased productivity in blade curve data import through the restart with another JSON file without

starting from scratch
▪ The previous 3D-CAD Models and Parts will be kept in the sim file and renamed with the prefix

OLD
▪ New models automatically relate to Regions, Continuum, and data analysis

• Adjoint support for Isentropic Efficiency Report
◦ See section Adjoint

Simcenter STAR-CCM+ 2602  |  Release Notes

SIEMENS DIGITAL INDUSTRIES SOFTWARE 21



User Guide
• New Tutorials

◦ Geometry
▪ 3D-CAD Assembly Constraints: Constraining a Linkage System

◦ Multiphase Flow
▪ Smoothed-Particle Hydrodynamics (SPH): Tire-Water Splash

◦ Design Exploration
▪ AI ROM: Minimizing Drag Around an Aerodynamic Body

• Modified Tutorials
◦ Adjoint Shape Optimization: Surface Sensitivity for S-Bend – account for change in turbulence

initialization procedure
◦ Adjoint Shape Optimization: Surface Mesh Morphing for Y-Junction Manifold – account for change

in turbulence initialization procedure
◦ Multi-Part Solid: Graphics Card Cooling – updated to use latest thin mesher
◦ Design Manager: Gradient-Based Optimization of a U-Bend – account for change in turbulence

initialization procedure
◦ Steady Flow: Laminar and Turbulent Flow in an S-Bend – account for change in turbulence

initialization procedure
◦ Volume Rendering: Steckler Room – write the sampled volume data to the SIMH file
◦ Flamelet Generated Manifold: Perfectly Premixed Combustion with Adaptive Meshing – apply the

use of stages
◦ GT-SUITE Co-Simulation: 1D Coupling – account for termination trigger
◦ Uniflow Two-Stroke Engine – update due to change of location for flow boundary diffusion setting
◦ Solid Oxide Fuel Cell – update due to change of location for flow boundary diffusion setting
◦ Conjugate Heat Transfer and Thermal Stress: Exhaust Manifold – revised inlet conditions
◦ Thermal Stress from Mapped Temperature Data: Exhaust Manifold – revised inlet conditions
◦ Airgap Remeshing: Electronic Speedometer – updated with new procedure for airgap remeshing
◦ Higher Order Magnetic Vector Potential: Axial Flux Motor – updated with new procedure for airgap

remeshing
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Important Notes 2602

This section contains important notes that you must become familiar with before using this latest release of
Simcenter STAR-CCM+. If you have questions about any of this information, please contact your Simcenter
customer support representative.

Java Upgraded to OpenJDK Version 21.0.8
The Java SDK (Software Development Kit), which is required to compile Java macros, has been upgraded to
OpenJDK v21.0.8 in the current release. Simcenter STAR-CCM+ ships with Eclipse Temurin 21.0.8 JDK. JDK
builds prior to 21.0.8 do not work, but later versions of JDK 21 are allowed (both OpenJDK-based distributions
and Oracle's JDK).

You need NetBeans 12.6 or Eclipse 2021-09 (4.21) or later to work with Java 21.

End of Support for Open MPI 4.0.3 and UCX 1.8.0
Support for Open MPI 4.0.3 and UCX 1.8.0 has been removed from the current release. More information
about both components can be found in "Using Open MPI" and "Using UCX" in the Simcenter STAR-CCM+ User
Guide, under Client-Server Setup > Working With Parallel Servers > Supported MPI Implementations.

Avoid .simh File Export with Lossy-Compression Resampled Volume from Version 2510
Due to the security related characteristics of the latest version of the compressed file format (Hierarchical Data
Format, or HDF), .hdf5, lossy compression is no longer compatible with the export of a resampled volume
derived part to the simulation history (.simh) file format.

Beginning with the current release, if you set Compression mode to Lossy for the export to a .simh file,
Simcenter STAR-CCM+ applies that compression mode to all selected inputs except for the resampled volume.

If you are using version 2510, do not set the .simh export with a resampled volume to lossy compression, due
to possible file corruption.

Additionally, you are advised not to import into the current release any .simh file exported from version 2510
with a resampled volume set to lossy compression.

End of Support for Inventor
Support for Inventor has been discontinued in the current release.

Pre-Processing: Planned End of Support for JT Open Toolkit (2610)
JT Open Toolkit for surface import has been deprecated since version 2506, and is planned to be retired
completely in version 2610. The recommended practice is to use Siemens Adapter to import JT files.

Interfaces: Changes to Mixing Plane Boundary Value Updates
In the current release, the introduction of Imprint Bins for the implicit mixing plane interface provides
imprinting based on circumferential binning. It ensures that the area-ratio per bin equals the pitch ratio, which
can improve the conservation of fluxes.
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At the same time, boundary value updates on implicit mixing plane interfaces have changed, particularly for
the relative differences of total temperature and total pressure across implicit mixing planes. The impact of this
change may be observable in solution results in the current release.

Finite Element Models
Changes to Iterative-Direct Solver Defaults

The Iterative-Direct Solver has new default property settings:

Property Default Setting
Preconditioner Precision Double
Preconditioner Reuse Activated
Matrix Symmetrization Deactivated
Block Low-Rank Deactivated

To restore the behavior of the solver as seen in the previous release, change these settings as follows:

Property Default Setting
Preconditioner Precision Single
Preconditioner Reuse Deactivated
Matrix Symmetrization Deactivated
Block Low-Rank Deactivated

A simulation file saved in a previous version of Simcenter STAR-CCM+ and using the Iterative-Direct solver
will be restored in the current release with the values above, so that its behavior is unchanged.

Transfer of Flow Boundary Diffusion
In previous releases, Flow Boundary Diffusion has been an option available on various physics models
including Segregated and Coupled Flow, Energy, Passive Scalar and various combustion models.
In the current release, the Flow Boundary Diffusion option has been removed from all the models. The
option now appears under the [boundary] > Physics Conditions folder on a boundary when a flow model
is present for the continuum associated with the region.

Adjoint
Changes to Topology Optimization Workflow

The topology optimization process has been improved, changing the procedure for the optimization
workflow. The design must now be updated before running the primal evaluation.
• The Topology Optimization solver now has a new Update Topology right-click menu action, as well

as more detailed solver settings:
◦ Solver Tolerance
◦ Maximum Iteration
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◦ Temporary Storage Retained
The Solver Frozen option has been removed.

• Simulation Operations include a new Update Topology operation.
When the current release of Simcenter STAR-CCM+ loads a simulation file that was saved in a previous
release with topology optimization, a new Update Topology operation is added automatically before the
Solve Physics operation.
More information can be found in "General Workflow for Adjoint Topology Optimization" in the Simcenter
STAR-CCM+ User Guide, under Physics Simulation > Adjoint > Adjoint Topology Optimization.

Planned Removal of Velocity Component Field Functions (2610)
The scalar field functions that represent residuals of individual velocity components has been deprecated
starting in Simcenter STAR-CCM+ 2510, and are planned to be removed in version 2610. These are:
• Adjoint of <Cost Function> w.r.t. Residual of Velocity-X
• Adjoint of <Cost Function> w.r.t. Residual of Velocity-Y
• Adjoint of <Cost Function> w.r.t. Residual of Velocity-Z
A single replacement is already available in the current release, a vector field function named Adjoint of
<Cost Function> w.r.t. Residual of Velocity.

Eulerian Multiphase (EMP): Changes to Viscous and Diffusion Terms
In the current release, improvements have been implemented in the treatment of the viscous/diffusion terms
in EMP. Therefore expect to observe some changes in results and convergence behavior.

Multiphase: Smoothed Particle Hydrodynamics
Planned Changes to Velocity Stabilization Option (2610)

The Basic and Advanced methods of the Incompressible Flow (ISPH) model's Velocity Stabilization Option
have been deprecated starting in the current release, and are planned to be removed in version 2610. The
remaining methods are None and Universal. If you use either of the two deprecated methods, it is
recommended that you select Universal.

Change to Cylinder Particle Refinement
For the Cylinder Particle Refinement of the Smoothed-Particle Hydrodynamics Adaptive Particles model, the
Radius property has been replaced by Outer Radius to allow simulation of a hollow cylinder (also using the
other property Inner Radius).

Solid Stress: Changes to Thermal Shell Parts
Due to the introduction of rigid contact for smooth shells in the current release, thermal shell parts used with
the Finite Element Solid Energy model are no longer compatible with fold lines. If you had set up shells in this
manner in a previous release of Simcenter STAR-CCM+, they do not work the same way in the current release.
Instead, Simcenter STAR-CCM+ generates an error message.

To compensate, use conformal edge-to-edge interfaces at the fold locations. In the case of coarse meshes,
check the specified dihedral angle tolerance (under the [physics continuum] > Reference Values > Geometry
Refinement Specification).
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Electromagnetism
New Airgap Remeshing Workflow

After recent solver refactoring, a new workflow exists for setting up electromagnetism cases with the Air
Gap Remesher (AGR). By using this new workflow, you may see a performance improvement. However,
without the workflow, you may observe performance regressions.
Specifically, the AGR parts should be separated from the other "surrounding air" parts and associated with
their own continuum. In practice, this typically means that the AGR parts need to be grouped into a rotating
region and a stationary region.
More information about using the AGR can be found in "Airgap Remeshing Workflow" in the Simcenter
STAR-CCM+ User Guide, under Physics Simulation > Electromagnetism > Airgap Remeshing.

Change to Modified Steinmetz Monitor
With the improved techniques of the Modified Steinmetz model, the Excitation Frequency property of the
Modified Steinmetz monitor has been removed.

Post-Processing
Changes to Scene View Triad

In the view triad of a scene ([scene] > Attributes > View Triad), settings for size and position have
changed. The Viewport property in previous releases, which used coordinates to control sizing and position,
has been replaced by two new properties:
• View Triad Position—lets you select the position of the view triad in the display.
• View Triad Size—specifies size as a fraction of the scene display.
Additionally, the same type of View Triad node appears within the studio scene (under [studio scene] >
Attributes). As with other types of scenes, this node has the Visible property with which you show or hide
the view triad. It replaces the Show View Triad property of the studio scene node in previous releases.
However, this studio scene equivalent of the View Triad node does not include the Text Color property.

Planned Removal of Block-Mapped Coordinate System (2606)
The block-mapped coordinate system has been deprecated starting in Simcenter STAR-CCM+ 2510, and is
planned to be removed in version 2606.

Planned End of Support for TRN File Format
Support for the .trn file is in deprecated mode (no updates or bug fixes will be done) starting in
Simcenter STAR-CCM+ 2402 and is planned for removal from a future version. Please use Solution Histories
(.simh file format) instead.

Simcenter STAR-CCM+ Viewer: Planned Shift of Viewer Technology (2606)
For version 2606, the downloadable (desktop) version of Simcenter STAR-CCM+ Viewer is planned to use the
same technology as Simcenter Web Viewer. Its user interface is expected to be very similar to that of the
current web-based version.

During this transition, the following features of the legacy desktop version will no longer be supported:

• Advanced rendering
• Ability to save a modified .sce file
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Depending on market demand, some or all of these features may be reintroduced in the new version.

The new Simcenter STAR-CCM+ Viewer will also be license-free.

Turbulence: Removal of V2F K-Epsilon Turbulence Model
The V2F K-Epsilon turbulence model was deprecated starting in Simcenter STAR-CCM+ 2302, was hidden in
the user interface (only available through macros), and has been removed completely from the current release.

The recommended practice is to use one of the Elliptic Blending K-Epsilon turbulence models.
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Macro API Changes 2602

This section contains the changes to the macro API since the previous release of Simcenter STAR-CCM+.

End of Volume Shapes Node Macros
Volume Shapes were deprecated starting in Simcenter STAR-CCM+ 2410 and have been removed from the
current release. Any simulation file saved in a previous release with Volume Shapes will restore in the current
release with Volume Shapes removed.

Any macros using the following classes listed below do not work in the current release:

• BrickVolumeShape.class
• ConeVolumeShape.class
• CylinderConeVolumeShape.class
• CylinderVolumeShape.class
• SphereVolumeShape.class
• VolumeShape.class
• VolumeShapeGroup.class
• VolumeShapeManager.class
• VolumeSource.class
• VolumeSourceManager.class
To update your macros, replace VolumeShape.class with the corresponding SimpleShapePart.class.

Previous Release Current Release

BrickVolumeShape brickVolumeShape_0 
= (BrickVolumeShape) 
simulation_0.get(VolumeShapeManager.c
lass).createBrickVolumeShape();

SimpleBlockPart simpleBlockPart_0 = 
simulation_0.get(MeshPartFactory.clas
s).createNewBlockPart(simulation_0.ge
t(SimulationPartManager.class));

ConeVolumeShape coneVolumeShape_0 
=(ConeVolumeShape)

simulation_0.get(VolumeShapeManager.c
lass).createConeVolumeShape();

SimpleConePart simpleConePart_0 =

simulation_0.get(MeshPartFactory.clas
s).createNewConePart(simulation_0.ge
t(SimulationPartManager.class));

    CylinderVolumeShape 
cylinderVolumeShape_0 
=(CylinderVolumeShape) 
simulation_0.get(VolumeShapeManager.c
lass).createCylinderVolumeShape();

SimpleCylinderPart 
simpleCylinderPart_0 =

simulation_0.get(MeshPartFactory.clas
s).createNewCylinderPart(simulation_0
.get(SimulationPartManager.class));

    SphereVolumeShape 
sphereVolumeShape_0 = 
(SphereVolumeShape) 
simulation_0.get(VolumeShapeManager.c
lass).createSphereVolumeShape();

SimpleSpherePart simpleSpherePart_0 =

simulation_0.get(MeshPartFactory.clas
s).createNewSpherePart(simulation_0.g
et(SimulationPartManager.class));
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For ignitors in reacting flow simulations, volume shape parts can no longer be used.

Meshing: Planned End of Initialize Meshing Feature
With the removal of Region-Based Meshing in 2302, the Initialize Meshing command in the macro code has
been deprecated starting in version 2406 and is planned for removal from a future version. To update your
macros, remove instances of:

meshPipelineController_0.initializeMeshPipeline();

Finite Element Models
Changes to Iterative-Direct Solver

As a result of improvements to the Iterative-Direct solver, the MumpsGmresIterativeSolver class has
been renamed to DirectGmresIterativeSolver. Do not use the class
MumpsGmresIterativeSolver any longer.

Previous Release Current Release

MumpsGmresIterativeSolver solver =
  
feSolidStressSolverMethods_0.getMeth
od(MumpsGmresIterativeSolver.class);

DirectGmresIterativeSolver solver =
  
feSolidStressSolverMethods_0.getMeth
od(DirectGmresIterativeSolver.class)
;

Transfer of Flow Boundary Diffusion
In previous releases, Flow Boundary Diffusion has been an option available on various physics models
including Segregated and Coupled Flow, Energy, Passive Scalar and various combustion models.
In the current release, the Flow Boundary Diffusion option has been removed from all the models. The
option now appears under the [boundary] > Physics Conditions folder on a boundary when a flow model
is present for the continuum associated with the region.
This improvement has resulted in changes to the macro code. The setting occurs on boundaries, so in the
example below, the code for the current release involves a case where a region named Region 1 is
assigned to the continuum Physics 1 and the region contains two boundaries, Boundary A and
Boundary B:

Previous Release Current Release

PhysicsContinuum physicsContinuum_0 
= 
simulation_0.getContinuumManager().g
etContinuum("Physics 1");
SegregatedFlowModel = 
segregatedFlowModel_0 = 
physicsContinuum_0.getModelManager()
.getModel(SegregatedFlowModel.class)
;

Region region_0 = 
simulation.getRegionManager().getReg
ion("Region 1");
Boundary boundary_0 = 
region_0.getBoundaryManager().getBou
ndary("Boundary A");
boundary_0.getConditions().get(FlowB
oundaryDiffusionOption.class).setSel
ected(FlowBoundaryDiffusionOption.Ty
pe.OFF);
Boundary boundary_1 = 
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Previous Release Current Release
segregatedFlowMOdel_0.setFlowBoundar
iesDiffusionEnabled(false);

region_0.getBoundaryManager().getBou
ndary("Boundary B");
boundary_1.getConditions().get(FlowB
oundaryDiffusionOption.class).setSel
ected(FlowBoundaryDiffusionOption.Ty
pe.OFF);

Adjoint: Changes to Topology Optimization Workflow
The topology optimization process has been improved, changing the procedure for the optimization workflow.
The design must now be updated before running the primal evaluation.

• The Topology Optimization solver now has a new Update Topology right-click menu action, as well as
more detailed solver settings:
◦ Solver Tolerance
◦ Maximum Iteration
◦ Temporary Storage Retained
The Solver Frozen option has been removed.

• Simulation Operations include a new Update Topology operation.

When the current release of Simcenter STAR-CCM+ loads a simulation file that was saved in a previous release
with topology optimization, a new Update Topology operation is added automatically before the Solve Physics
operation.

More information can be found in "General Workflow for Adjoint Topology Optimization" in the Simcenter
STAR-CCM+ User Guide, under Physics Simulation > Adjoint > Adjoint Topology Optimization.

This improvement has resulted in a change to the macro code. Specifically, add the following line

loopAutomationBlock_0.getBlocks().createBlock("star.topologyoptimization.Update
TopologyAutomationBlock", "Update Topology");

to macro code before the Solve Physics operation, such as in the example below:

loopAutomationBlock_0.setSelectedPredicate(automationScalarExpressionPredicate_
0);
automationScalarExpressionPredicate_0.getQuantity().setDefinition("$Loop < 
$MaxSteps");

loopAutomationBlock_0.getBlocks().createBlock("star.topologyoptimization.Update
TopologyAutomationBlock", "Update Topology");
loopAutomationBlock_0.getBlocks().createBlock("star.common.SolvePhysics", 
"Solve Physics");
loopAutomationBlock_0.getBlocks().createBlock("star.common.SolveAdjoint", 
"Solve Adjoint");

Turbulence: Change to Reference Velocity
For reference velocity in turbulence modeling, the way in which initial velocity is specified has changed,
resulting in changes to the macro code. These changes include the addition of
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TurbulentVelocityScaleOption to the InitialConditionManager. To update your macros, add the
line

physicsContinuum_0.getInitialConditions().get(TurbulentVelocityScaleOption.clas
s).setSelected(TurbulentVelocityScaleOption.Type.SPECIFIED);

as shown in the example below.

Previous Release Current Release

PhysicsContinuum physicsContinuum_0 =
                                    
((PhysicsContinuum) 
simulation_0.getContinuumManager().ge
tContinuum("Physics 1"));
                                    
                                    
SstKwTurbModel sstKwTurbModel_0 =
                                    
physicsContinuum_0.getModelManager().
getModel(SstKwTurbModel.class);
                                    
                                    
sstKwTurbModel_0.getKwTurbConstitutiv
eOption().setSelected(KwTurbConstitut
iveOption.Type.CUBIC);
                                    
                                    
TurbulentVelocityScaleProfile 
turbulentVelocityScaleProfile_0 =
                                    
physicsContinuum_0.getInitialConditio
ns().get(TurbulentVelocityScaleProfil
e.class);
                                    
                                    
((ConstantScalarProfileMethod) 
turbulentVelocityScaleProfile_0.getMe
thod()).getQuantity().setValue(20);
                                    
                                    
KwTurbSolver kwTurbSolver_0 =
                                    
((KwTurbSolver) 
simulation_0.getSolverManager().getSo
lver(KwTurbSolver.class));
                                    
                                    
kwTurbSolver_0.setLeaveTemporaryStora
ge(true);

Simulation simulation_0 =  
getActiveSimulation();
                                    
                                    
PhysicsContinuum physicsContinuum_0 =
                                    
((PhysicsContinuum) 
simulation_0.getContinuumManager().ge
tContinuum("Physics 1"));
                                    
                                    
SstKwTurbModel sstKwTurbModel_0 =
                                    
physicsContinuum_0.getModelManager().
getModel(SstKwTurbModel.class);
                                    
                                    
sstKwTurbModel_0.getKwTurbConstitutiv
eOption().setSelected(KwTurbConstitut
iveOption.Type.CUBIC);
                                    
                                    
physicsContinuum_0.getInitialConditio
ns().get(TurbulentVelocityScaleOption
.class).setSelected(TurbulentVelocity
ScaleOption.Type.SPECIFIED);
                                    
                                    
TurbulentVelocityScaleProfile 
turbulentVelocityScaleProfile_0 =
                                    
physicsContinuum_0.getInitialConditio
ns().get(TurbulentVelocityScaleProfil
e.class);
                                    
                                    
((ConstantScalarProfileMethod) 
turbulentVelocityScaleProfile_0.getMe
thod()).getQuantity().setValue(20);
                                    
                                    
KwTurbSolver kwTurbSolver_0 =
                                    
((KwTurbSolver) 
simulation_0.getSolverManager().getSo
lver(KwTurbSolver.class));
                                    
                                    
kwTurbSolver_0.setLeaveTemporaryStora
ge(true);
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Multiphase: Smoothed Particle Hydrodynamics
Changes to Stabilization Macro Codes

The Free Surface Stabilization Option and the Free Surface Stabilization Factor have been renamed to the
Velocity Stabilization Option and the Velocity Stabilization Coefficient, respectively. Therefore, the
corresponding macro commands have been renamed accordingly. (The old commands are no longer valid.)
Update your macro code as follows:
• Change instances of (…)FreeSurfaceStabilizationOption to

(…)VelocityStabilizationOption
• Change instances of (…)FreeSurfaceStabilizationFactor to

(…)VelocityStabilizationCoefficient

Planned Change to Cylinder Particle Refinement Macro Code (2606)
For the Cylinder Particle Refinement of the Smoothed-Particle Hydrodynamics Adaptive Particles model, the
Radius property has been replaced by Outer Radius to allow simulation of a hollow cylinder (also using the
other property Inner Radius).
The corresponding Java macro with getRadius has been deprecated starting in the current release, and is
planned to be removed in version 2606. You are advised to replace it with getOuterRadius.

Mixture Multiphase (MMP): Change to Schrage Extrapolation
In the current release, SchrageExtrapolatedSaturationPressureMethod was moved from
mixturemultiphase to energy. To update your macros, change instances of

star.mixturemultiphase.SchrageExtrapolatedSaturationPressureMethod

to

star.energy.SchrageExtrapolatedSaturationPressureMethod

Lagrangian Multiphase (LMP): Changes to Latent Heat Methods
To improve efficiency, the calculations of energy source terms have been relocated, resulting in changes to the
macro code.

star.energy.LatentHeatMethod has been changed to star.multiphase.LatentHeatMethod

Previous Release Current Release

import star.energy.LatentHeatMethod;
phaseInteractionMaterial_0.getMateria
lProperties().getMaterialProperty(Lat
entHeatProperty.class).setMethod(Late
ntHeatMethod.class);

import 
star.multiphase.LatentHeatMethod;
phaseInteractionMaterial_0.getMateria
lProperties().getMaterialProperty(Lat
entHeatProperty.class).setMethod(Late
ntHeatMethod.class);

star.lagrangian.spray.DhLatentHeatMethod has been changed to
star.multiphase.DhLatentHeatMethod
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Previous Release Current Release

import 
star.lagrangian.spray.DhLatentHeatMet
hod;
singleComponentDropletMaterial_0.getM
aterialProperties().getMaterialProper
ty(VaporizationLatentHeatProperty.cla
ss).setMethod(DhLatentHeatMethod.clas
s);

import 
star.multiphase.DhLatentHeatMethod;
singleComponentDropletMaterial_0.getM
aterialProperties().getMaterialProper
ty(VaporizationLatentHeatProperty.cla
ss).setMethod(DhLatentHeatMethod.clas
s);

Electromagnetism: Change to Modified Steinmetz Monitor
With the improved techniques of the Modified Steinmetz model, the Excitation Frequency property of the
Modified Steinmetz monitor has been removed.

The removal of this property resulted in changes to the macro code. Specifically, calls to the
getFrequency() method of the FieldModifiedSteinmetzMonitor in Java macros are no longer
supported. Remove lines that use it from your macro codes, such as the second line in the example below:

FieldModifiedSteinmetzMonitor steinmetzMonitor =  
sim.getMonitorManager().createMonitor(FieldModifiedSteinmetzMonitor.class);
steinmetzMonitor.getFrequency().setDefinition("$f"); // No longer possible

Post-Processing: Changes to Scene View Triad
In the view triad of a scene ([scene] > Attributes > View Triad), settings for size and position have changed.
The Viewport property in previous releases, which used coordinates to control sizing and position, has been
replaced by two new properties:

• View Triad Position—lets you select the position of the view triad in the display.
• View Triad Size—specifies size as a fraction of the scene display.

Additionally, the same type of View Triad node appears within the studio scene (under [studio scene] >
Attributes). As with other types of scenes, this node has the Visible property with which you show or hide the
view triad. It replaces the Show View Triad property of the studio scene node in previous releases. However,
this studio scene equivalent of the View Triad node does not include the Text Color property.

These modifications have resulted in changes to the macro code:

Scenes

• setAxesViewport and getAxesViewport are now deprecated but are compatible with the new View
Triad Position and View Triad Size properties.

• setAxesPositionEnum(AxesViewportPosition pos) and AxesViewportPosition
getAxesPositionEnum() have been added for the new View Triad Position property.

• setAxesSize(double size) and double getAxesSize() have been added for the new View
Triad Size property.

Studio Scenes

• StudioSceneViewTriadSettings getViewTriadSettings() has been added and allows
retrieval of the new node View Triad in the studio scene.
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• boolean getNavigationCubeVisibility() and setNavigationCubeVisibility(boolean
v) are now deprecated but are compatible with this version.

• The class StudioSceneViewTriadSettings has been added to manage the view triad properties. It
contains the following methods that correspond to the Visible, View Triad Position, and View Triad Size
properties:
◦ boolean getVisible(),
◦ void setVisible(boolean visible)
◦ AxesViewportPosition getPosition()
◦ setPosition(AxesViewportPosition pos)
◦ double getSize()
◦ void setSize(double size)

• The enum class AxesViewportPosition has been added and contains the different available positions
TOP_LEFT, BOTTOM_RIGHT, TOP_RIGHT, and BOTTOM_LEFT.

The following is an example of triad parameterization in the studio scene:

private void execute0() {
             Simulation simulation_0 = getActiveSimulation();
             StudioScene studioScene_0 = ((StudioScene) 
simulation_0.getSceneManager().getObject("Scalar Studio"));
             StudioSceneViewTriadSettings studioSceneViewTriadSettings_0 = 
studioScene_0.getViewTriadSettings();
             studioSceneViewTriadSettings_0.setVisible(false);
             studioSceneViewTriadSettings_0.setVisible(true);
             
studioSceneViewTriadSettings_0.setPosition(AxesViewportPosition.TOP_LEFT);
             
studioSceneViewTriadSettings_0.setPosition(AxesViewportPosition.BOTTOM_RIGHT);
             
studioSceneViewTriadSettings_0.setPosition(AxesViewportPosition.TOP_RIGHT);
             
studioSceneViewTriadSettings_0.setPosition(AxesViewportPosition.BOTTOM_LEFT);
             studioSceneViewTriadSettings_0.setSize(0.5);
}
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CAD Package Support

This section contains a list of supported CAD Clients, the CAD import versions, and the CAD export versions.

CAD Packages for CAD Clients
When installing CAD Clients, the target CAD package must be present on the installation machine. Without
this, you can force the installation of a particular sub-component, but there is no guarantee that this will work
correctly with your CAD package. The following CAD packages are required to run the CAD Clients:

CAD Client CAD Package Version Comments
Simcenter
STAR-CCM+
Client for
CATIA V5

CATIA V5-6R2021 (R31) An additional ME2 or MD2 + GPS configuration license is
required from Dassault Systemes to run Simcenter STAR-CCM+
Client for CATIA V5.

CATIA V5-6R2022 (R32)
CATIA V5-6R2023 (R33)
CATIA V5-6R2024 (R34)
CATIA V5-6R2025 (R35)

Simcenter
STAR-CCM+
Client for NX

NX 2212/Simcenter 3D
2212

For all supported version of NX or Simcenter 3D, you can use a
batch version of NX or Simcenter 3D on Linux in conjunction
with Simcenter STAR-CCM+.NX 2306/Simcenter 3D

2306
NX 2312/Simcenter 3D
2312
NX 2406/Simcenter 3D
2406
NX 2412/Simcenter 3D
2412
NX 2506/Simcenter 3D
2506
NX 2512/Simcenter 3D
2512

Simcenter
STAR-CCM+
Client for Creo

Creo Parametric 7.0
Creo Parametric 8.0
Creo Parametric 9.0
Creo Parametric 10.0
Creo Parametric 11.0
Creo Parametric 12.0
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CAD Import Versions
CAD File Formats for Siemens Adapter

File Format File Extensions Versions
Supported

Add-on Required Type of Import

ACIS .sat, .sab Up to 2023 1.0 CAD Exchange B-rep
CATIA V4 .model Up to 4.2.5 CAD Exchange B-rep
CATIA V5 .CATPart, .CATProd

uct, .CGR
Up to V5-6R2024
SP4

CAD Exchange B-rep

CATIA
V6/3DExperience

.3DXML Up to R2025x CAD Exchange B-rep

Creo - Pro/E .prt, .asm Up to Creo 11 CAD Exchange B-rep
IFC .ifc IFC2x3, IFC4 CAD Exchange B-rep
IGES .igs, .iges 5.1, 5.2, 5.3 None B-rep
JT .jt Up to v10.7.1 None B-rep
Rhino .3dm Up to 7 CAD Exchange B-rep
Solid Edge .par, .asm Windows up to

2025
Linux — no support

None B-rep

SolidWorks .sldprt, .sldasm Up to 2025 CAD Exchange B-rep
STEP .stp, .step AP 203 Ed2, AP 214

Ed3, AP 242 Ed1,
Ed2, and Ed3

None B-rep

NX .prt Up to NX2506 None B-rep

Siemens Neutral Formats

File Format File Extensions Versions
Supported

Add-on Required Type of Import

Parasolid .x_t, .x_b, .xmt_txt,
.xmt_bin

Up to 38.0.185 None B-rep

PLMXML .plmxml, .xml Up to 7.2.2.044 None N/A

CAD Export Versions
CAD export is available on all platforms. 3D-CAD supports exporting to the following file formats:

File Format File Extensions Versions Supported Add-on Required Type of Export
Parasolid .x_t, .x_b 38.0.185 None B-rep
IGES .igs, .iges 5.3 None B-rep
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File Format File Extensions Versions Supported Add-on Required Type of Export
STEP .stp, .step AP 203 E1/E2, AP

214, AP 242
None B-rep
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External Packages Support

Simcenter STAR-CCM+ can interact with a range of third-party software tools, either by importing their meshes
and data, exporting to their formats, or through co-simulation.

Third-Party Software
Simcenter STAR-CCM+ supports the following packages:

Package Provider Supported Versions Import Export File-
Based

Couplin
g

Co-
Simulat

ion[2]

Abaqus SIMULIA-Dassault
Systemes

All ✓ ✓[3] ✓
2024
2023
2022

✓

Simcenter Amesim Siemens Digital
Industries
Software

2019.2
2019.1
17

- - - ✓

CGNS Format Open source
standard https://
cgns.org/

4.3.0 ✓ ✓ ✓

ANSYS ANSYS Inc. All ✓[4] ✓[3] ✓
Simcenter Battery
Design Studio

Siemens Digital
Industries
Software

2506 ✓ - - -

Ensight ANSYS Inc. 10.1 (recommended)
9
8

✓ ✓[5] - -

FieldView FieldView CFD 15 - ✓[5] - -
gPROMS Process Systems

Enterprise Limited
- A Siemens
Business

gPROMS
FormulatedProducts 2.0
gPROMS ModelBuilder 7.0
gPROMS ProcessBuilder 2.0

- ✓[5] ✓ -

GT-SUITE Gamma
Technologies Inc.

2024
2023
2022

- - - ✓

JMAG JSOL Corporation JSOL defines the JMAG
versions that are supported

✓

Simcenter Nastran Siemens Digital
Industries
Software

All ✓[4] ✓[3] ✓
2506
2412

✓
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Package Provider Supported Versions Import Export File-
Based

Couplin
g

Co-
Simulat

ion[2]

2406
MSC Nastran MSC Software

Solutions
All ✓[4] ✓[3] ✓ -

TAITherm
(Formerly known
as RadTherm)

ThermoAnalytics
Inc.

All ✓ ✓[3] ✓ -

Simcenter SPEED Siemens Digital
Industries
Software

2212 ✓ - - -

Tecplot 360 Tecplot Inc. 2015 ✓[5] - -

2 Currently, co-simulation does not support host specification using the IPv6 communication protocol
3 Exports solution data, but not the mesh
4 There is no version restriction on the files to import
5 Exports mesh and solution data
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Known Issues

This section contains a list of known issues that may occur in special circumstances. None of the issues affect
the validity of the results that you obtain with Simcenter STAR-CCM+.

In the following topics, the symbol  is used to identify issues that are new in this release. Only issues
where resolution is related to a third-party product or system provider, and is outside of our control, are listed
here.

A number of these issues pertain to Message Passing Interfaces (MPIs). For more information about MPIs, see
"Supported MPI Implementations" in the Simcenter STAR-CCM+ User Guide.

Contents:
Issues Relevant to All Operating Systems
Issues Relevant to Linux
Issues Relevant to Windows
Issues Relevant to the CAD Clients

Issues Relevant to All Operating Systems
This section contains a list of known issues that affect Simcenter STAR-CCM+ on all operating systems.

Possible Performance Issues on AMD Zen 2 and Zen 3 CPUs
For selected cases it is possible that Simcenter STAR-CCM+ simulations do not perform optimally with the
automatically selected AMD AOCL math library on older generations of AMD CPUs. If performance regressions
are observed it may help to use an Intel MKL version from a previous Simcenter STAR-CCM+ installation. For
example, you can use Intel MKL 2020.0.106 from Simcenter STAR-CCM+ 2410 by providing the location of
libmkl_rt.20.so as the argument to the option -flexiblaslib and setting the environment variable
MKL_DEBUG_CPU_TYPE=5.

Co-Simulation with Abaqus 2023: Abaqus Restart Files
When the time-step in Abaqus is smaller than the coupling time interval, Abaqus may ignore the NUMBER
INTERVAL keyword specified for the *RESTART command in the Abaqus input (*.inp) file. Therefore, Abaqus
may not write the restart frames at the interval specified using the NUMBER INTERVAL keyword.

System Dialog Required for Exporting Simulation Guide to PDF
PDF exports from the Simcenter STAR-CCM+ simulation guide have been observed to contain text overlap. This
issue has been attributed to the third-party library Chromium.

To avoid this overlap, use the system dialog:

1. In the simulation guide, after activating the Print functionality, click More settings in the right-hand
sidebar.

2. At the bottom of the sidebar, click Print using system dialog.
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Intel Xe Found to Cause Display Issues
Scalar displays have been observed to appear incorrect on Windows systems using Intel Xe / Intel Iris Xe
graphics. This issue has been attributed to the drivers that are currently supplied with Intel Xe graphics (part of
recent Intel CPUs as well as dedicated GPUs). At the time of writing, desktop and mobile computers with Intel
Core processors using their integrated Intel XE graphics units may be affected. This applies to the 11th, 12th,
and 13th processor generations, that is, Intel Core i(3/5/7)-(11/12/13)XXXX.

The situation on Linux regarding this issue is unknown.

As a remedy, switch the Contour Style property of the scalar displayer to Filled or Smooth Filled.

MPI Issues Found with Simcenter STAR-CCM+ to Simcenter STAR-CCM+ Co-Simulation
Issues have been observed when MPI applications are used to spawn a second parallel Simcenter STAR-CCM+
simulation from an existing parallel simulation.

You are advised to use Resource Manager for this type of co-simulation. See the section "Running a Co-
Simulation Using Resource Manager" in the Simcenter STAR-CCM+ User Guide.

Custom Display Scaling Not Supported in Current Release
In the current release, it is recommended that you avoid using your system display settings for scaling
Simcenter STAR-CCM+. Issues have been observed such as blurry fonts, incorrectly registered mouse clicks, and
the inability to select objects in a scene display.

To prevent scaling of Simcenter STAR-CCM+ in Linux, add -jvmargs -Dsun.java2d.uiScale=1.0 to the
command line.

To change the size of Simcenter STAR-CCM+ client fonts, see either of the following:

• All platforms: "Changing the Workspace Font Size" in the Simcenter STAR-CCM+ User Guide
• Windows 10: Preventing Windows from Scaling Simcenter STAR-CCM+

AVX-512 Optimizations on Newer Intel CPUs Can Lead to Spurious Numerical Failures
Simcenter STAR-CCM+ finite element solvers and some meshing modules depend on the Intel Math Kernel
Library (MKL) for performance-critical linear algebra subroutines. The AVX-512 optimizations inside the MKL
library can be too aggressive and cause the linear system solution process to fail even for a valid input.

If your system has an AVX-512 capable Intel CPU and the solver fails to produce a result due to a floating point
exception, you can try setting the environment variable MKL_ENABLE_INSTRUCTIONS to a value of AVX2.
This setting can help to stabilize the system. For example:
• Bash shell: export MKL_ENABLE_INSTRUCTIONS=AVX2
• C shell (csh or tcsh): setenv MKL_ENABLE_INSTRUCTIONS AVX2
This setting configures the MKL library to avoid optimizations that are only appropriate for architectures more
recent than Intel AVX2. For more details, see https://software.intel.com/en-us/mkl-linux-developer-guide-
instruction-set-specific-dispatching-on-intel-architectures.

Hyperthreading Should be Disabled on Systems Running Simcenter STAR-CCM+
Siemens Digital Industries Software currently recommends that you disable hyperthreading on systems that
will be used to run Simcenter STAR-CCM+. For front-end nodes running only Simcenter STAR-CCM+ clients,
hyperthreading is not expected to have any adverse effects.
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Simcenter STAR-CCM+ May Not Run in Conjunction with Synergy
There are reports of Simcenter STAR-CCM+ failing to launch on platforms that use Synergy to share a mouse
and keyboard between platforms. This is due to an open bug in the Java JDK, as reported on the JDK Bug
System: https://bugs.openjdk.java.net/browse/JDK-6322854.

XWindows Can Cause Problems
If you use XWindows software, especially on Windows, to "display" a Simcenter STAR-CCM+ client back to the
local machine from a remote machine, various problems may occur, such as the remote client not starting
correctly or at all. This method of working is not supported by Simcenter STAR-CCM+. You must run the client
directly on your local machine and connect to a remote Simcenter STAR-CCM+ server.

Zero-Sized Files in Some NFS Systems
In some newer NFS systems, if the disk becomes full while you are saving a simulation file, a zero-sized
simulation file is written to the disk. No error message appears.

Issues Relevant to Linux
This section contains a list of known issues that affect Simcenter STAR-CCM+ on Linux operating systems.

Backspace Key Not Correctly Interpreted in SIP Installer in Console Mode on Linux
To work with the Siemens Install Program (SIP) in console mode on Linux, you must first configure the
backspace functionality so that it works as expected.

Since cursor and keypad keys do not work, ensure the chosen Linux terminal is configured to send ^H as the
equivalent of the backspace key.

Compatibility Issue with AMD CPUs Based on Zen 3 Microarchitecture
Compatibility issues have been found between the AMD CPUs based on the Zen 3 microarchitecture, such as
the AMD EPYC Milan CPU family, and the currently supported version of the OpenSWR Mesa driver. If you are
using this type of CPU, you are advised to launch Simcenter STAR-CCM+ with the argument -graphics mesa
(at the cost of graphics performance).

Libraries Required with Simcenter STAR-CCM+ Client for NX on Linux
To run Simcenter STAR-CCM+ Client for NX on Linux, supported versions of NX must be accompanied by the
installation of the following runtime libraries:

• libGLU.so.1
• libXm.so.4
Without these libraries, an error message appears when an attempt is made to update the geometry.

Latest Workspace Fonts May Require Anti-Aliasing
On some Linux systems, the latest Simcenter STAR-CCM+ workspace fonts have had issues such as blurriness.
The workaround is to activate font anti-aliasing in your operating system settings.
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The following example is a workaround for activating anti-aliasing in KDE. It is offered only as an example for a
particular operating system. For instructions on your operating system, refer to its user documentation.

1. Launch KDE settings.
2. Under Look & Feel, click Appearance.
3. Navigate to Fonts.
4. Next to Use Anti-Aliasing, choose Enabled from the drop-down box.

Line Integral Convolution Does Not Work Properly with Intel Graphics Chipsets on
Linux
Vector scenes that are set to display Line Integral Convolution (LIC) do not render properly on Intel graphics
chipsets. This is due to issues with the Intel graphics driver. As a result, LIC is disabled on Intel graphics chipsets
on Linux.

lmutil: "command not found" Error
On Linux platforms not conforming to the minimum LSB 3.0 (Linux Standard Base) requirement, a command
not found error may appear when attempting to launch lmutil for the FLEXlm licensing. If this occurs, you must
upgrade to LSB 3.0 or higher.

Shared Memory Limits Too Low
Linux workstations are often configured with low limits on the amount of allowable shared memory. This
restricts how much memory can be pinned by the libraries that MPI uses. These libraries can print warning
messages even when only using a single host and they usually indicate the limits are set too low-even if the
library isn't being used. Some example error messages are displayed below:
• Open MPI:

The OpenIB BTL failed to initialize while trying to allocate some locked 
memory. 
This typically can indicate that the memlock limits are set too low. 
For most HPC installations, the memlock limits should be set to 
"unlimited".

The failure occurred here:

Host: compute_node.example.com
OMPI source: btl_opebib.c:114
Function: ibv_create_cq()
Device: Out of memory
Memlock limit: 32767

The Open MPI Frequently Asked Questions describe how the limits are changed. See the answer to How
can a system administrator (or user) change locked memory limits?.

To resolve these types of issues, set workstations to have high (or preferably unlimited) limits.

Simcenter STAR-CCM+ Viewer Fails to Run If Required Libraries Are Not Found
In the current release, Simcenter STAR-CCM+ Viewer requires the following libraries:

• xkbcommon and xkbcommon-x11—these are standard system libraries that are typically already
installed.

• GNU C library version 2.12 or greater
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• GIMP Toolkit (GTK+) version 2.20 or greater

If Simcenter STAR-CCM+ Viewer cannot detect these versions, it generates an error message.

If you have these versions installed on your machine and you still get this error, it may be that your
xkbcommon and GTK+ libraries are installed in a location other than the global packages location.
Simcenter STAR-CCM+ Viewer expects to find these libraries in the global packages location, typically /usr.

If you installed GTK+ version 2.20 or greater in a different location:

• Add the path to your pkgconfig directory to the PKG_CONFIG_PATH variable. An example bash shell
command is shown below:

% export PKG_CONFIG_PATH=[GTK+_INSTALL_DIR]/lib/pkgxonfig:$PKG_CONFIG_PATH
• Add the path to your lib directory to the LD_LIBRARY_PATH variable. An example bash shell command

is shown below:

% export LD_LIBRARY_PATH=[GTK+_INSTALL_DIR]/lib:$LD_LIBRARY_PATH

Similarly, if you installed the xkbcommon libraries in a different location, add the path to your lib directory to
the LD_LIBRARY_PATH variable. An example bash shell command is shown below:

% export LD_LIBRARY_PATH=[XKBCOMMON_INSTALL_PATH]/lib:$LD_LIBRARY_PATH

Issues Relevant to Windows
This section contains a list of known issues that affect Simcenter STAR-CCM+ on Windows operating systems.

FlatLaf Issue Causes UI Exception with Toolbar Drop-Downs
Due to an issue with FlatLaf, the third-party code that underlies part of the Simcenter STAR-CCM+ user
interface, a toolbar drop-down feature can lead to errors. When the mouse pointer hovers over the drop-down
arrow that accesses obscured toolbar icons, an exception occurs.

This issue is expected to be fixed in the near future. Until then, it is recommended either to widen the window
so the icons are all displayed, or to customize your toolbar settings to remove lesser-used icons or toolbars.

Windows Update KB4598291 Required for Users of Windows 10 Versions 2004 and
20H2
Microsoft has made available a patch, KB4598291, to fix an error in Windows 10 Versions 2004 and 20H2. For
reliable use on Windows of Simcenter STAR-CCM+, especially in parallel, you are advised to make sure your
system includes this fix.

For details, see the page on Microsoft's Support site.

Some Scene/Plot Exports Fail on Windows When Output Points to Linux Network Folder
When using Simcenter STAR-CCM+ on Windows, if you attempt to export certain data from a scene (hardcopy
image) or a plot (hardcopy image or .csv file) to a location on a Linux host that is mapped to your Windows
drive via Samba sharing, Simcenter STAR-CCM+ generates a message that the selected location is "not
writable". This occurs even when you have full write permission on the Samba drive.
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In this situation, it is recommended that you export such files to your local Windows drive.

Exiting Some Screenshot Tools Causes Simcenter STAR-CCM+ Client Exception
When you take screenshots with software such as the Windows 7 Snipping Tool or SnagIt, the
Simcenter STAR-CCM+ client may undergo a fatal error after you exit the screenshot tool. Such an error can
also occur when you reactivate Simcenter STAR-CCM+ after exiting the screenshot tool.

To prevent this error, do one of the following:

• Manually activate an application other than Simcenter STAR-CCM+ before closing the screenshot tool.
You can then switch to Simcenter STAR-CCM+ from the third application without causing the fatal error.

• Minimize the screenshot tool but leave it running.

Context-Sensitive Help Not Compatible with Microsoft Edge
When using Microsoft Edge as the default browser, help pages do not open at the correct location when you
press F1 for a selected node in the simulation tree. To avoid this issue, use an alternative browser such as
Firefox or Google Chrome.

Internet Explorer May Block Access to the Help System
When using Internet Explorer to access the User Guide, you may see the following message:

To help protect your security, Internet Explorer has restricted this file from 
showing active content that could access your computer.

You can then click for the option to Allow Blocked Content, which will then produce a Security Warning that
says:

Allowing active content such as script and ActiveX controls can be useful, but 
active content might also harm your computer.
Are you sure you want to let this file run active content?

To allow this content to run without getting blocked please follow these steps:
1. Open Internet Explorer.
2. Go to the Tools > Internet Options > Advanced tab.
3. Scroll down to the section labeled Security.
4. Activate the Allow active content to run in files on My Computer option.
5. Click OK and then close the Internet Options window.

Warnings About Network Access
If you have a personal firewall (for example, Norton Internet Services) that is set up to warn you about network
access from your computer, you may get warnings about an IP address being accessed on port 47827. This is
caused by the session locator sending a multicast query looking for Simcenter STAR-CCM+ servers on your local
network.

When the client is started without a specified simulation file (the default when Simcenter STAR-CCM+ is started
via the Start > [programs menu] > Siemens Simcenter STAR-CCM+ > Simcenter STAR-CCM+ [version
number] [(build number)] menu on Windows 10), the session locator is started (in case you are attempting to
connect to a running server). If you then open a simulation file or connect to a running server, the session
locator stops. It restarts if you go to the Servers tab in the Simcenter STAR-CCM+ explorer window.
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Open that port to prevent the warning, or if you are running from the command line, the -loc argument
prevents the session locator starting.

Issues Relevant to the CAD Clients
This section contains known issues that affect the CAD Clients.

Simcenter STAR-CCM+ Installer Chooses to Install NX Components Even Though NX is
not Installed
On a machine where NX has been installed and subsequently removed, the Simcenter STAR-CCM+ installer
may choose to install the NX components even though the CAD software is no longer present. This is due to
the NX uninstaller not removing all relevant information from the Windows registry.
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Credits

Simcenter STAR-CCM+ makes use of several third party software components to provide certain features within
its code.

For details about the licensing of these components, refer to the file ReadMe_OSS.html which is included in
the root installation directory of Simcenter STAR-CCM+: 21.02.###/STAR-CCM+21.02.###.
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